
 
 

February 2, 2015 

Tonight’s Agenda 

Questions     Adding People to Your Tree 

Latest Update Information   Creating Smart Stories™ 

Review Workspace Tabs   Adding Photos, Documents, and Notes 

Planning and Building Your Tree  Saving and Sending Your Smart Story to Relatives 

References to numbered bracket boxes, ie, [1], in each paragraph are shown in each figure 

located above or below the numbered paragraphs. Many tips are included below to help your 

genealogy research. 

Latest Update 

 

Family Maker 2014 has had several software updates. The latest version is 22.0.0.345. Inside this 

update are fixes for several known software bugs. More features may be included in later 

upgrades. 

 

Review Workspace Tabs 

 

From our last class, we introduced the new screen layouts that include seven tabs across the top. 

The tabs allow users to access different key parts of the software program. The tabs are: Plan (to 

build your tree), People (adding people to your tree), Places (locating ancestors on over 3 

million maps), Media (add document images, photographs, videos, and audio clips of your 

ancestors), Sources (manage sources and citations), Publish (allows users to create genealogy 

reports or a book), and Web Search (allows users to search many different databases in locating 

ancestors). 

 

Building A New Tree 

 

[1] If you start with a new tree without importing any family file information is very simple as 

shown in Figure 1 on the next page. Select the button on ‘Enter what you know.’ Start with 

your name and enter your birth information and your parent’s names. Then add the tree name 

and select continue. A new screen appears under the ‘People’ tab. Users can now add new 

people to this screen. 

 

Tip: After you start your tree, contact your relatives to see if they have already done a genealogy 

tree for your ancestors.  You might be surprised to find several cousins may have lots of 

genealogy information on the same ancestors, so why reinvent the wheel? Just be sure they have 
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cited their sources for accuracy of the same ancestors. Also don’t trust the many Internet family 

trees as many are not accurate and don’t have their sources verified. 

 

Be sure to be detailed as possible on the information that you enter into these blank spaces. It’s 

important to be accurate otherwise the relationship and date calculators will spot any errors and 

alert you to the problem area.  

 

Note: You have the option to capitalize surnames or not, but be sure to use maiden names on all 

women for consistent results. Use backslashes on surnames with multiple surnames, ie, European 

names. 

 

 
Figure 1. New Tree Introduction 

 

[2] If you have an existing family file to import, select the button ‘Import a tree from an 

existing file’ as shown above. Select the ‘Browse’ button, then select your family file from the 

correct folder in your older FTM program (usually located in the FTW folder) in the C hard drive 

under the ‘My Computer’ icon on your Windows desktop. Most of the time FTM will show the 

correct folder using their automatic search feature. Select the preferred family file to import. This 

process can take several minutes up to five minutes to import depending on your computer and 

file size. A third option is to download a family tree directly from Ancestry.com.  

 

1 2 
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Tip: However, a word of caution is not to download or merge their tree until you have 

reviewed it carefully for reliable and correct information. Always verify the information, 

because once you have merged the tree, you can’t undo it. Once the file has been imported, users 

can begin adding to this family file. A new screen appears as shown in Figure 2 below. 

 

If you build a new tree or import your family file into the program, users can select their home 

person from the People tab by right clicking on the selected individual and selecting ‘Set as 

Home person.’ Looking at the Plan tab reveals your ancestor as the home person on the current 

tree screen. The home person is the key person in your tree. It normally would be yourself, but 

can be anyone you designate. The internal relationship calculator determines what relationship 

the selected person is to the home person on other screens. The home person can be changed at 

any time. The Current Tree tab shows your current family file. 

 

Tip: Notice the family file name (Coffin – Pierson 12-01-9) is located at the very top in the black 

bar before the software name of Family Tree Maker 2014. It’s always recommended that you 

date each family file you create to prevent confusion with duplicate file names of the same name. 

Always select the latest family file if you create duplicate family files. You will always have a 

backup file associated with the main family file upon closing the program. 

 

 
Figure 2. Current Tree Screen 
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Tip: I recommend working on only one large tree instead of multiple trees on multiple family 

lines. The exception would be if helping relatives with specific family lines. There is less chance 

of making mistakes with one tree. 

 

Notice there are four sections to the Plan workspace screen. At the top is the [1] current tree 

showing either the home person or other ancestor with the family file stats to the right, and 

information on the file creation and backup information below.  

 

[2] Tasks to be completed as shown by clicking on ‘New’ to enter a new task for a tracking 

journal. A new text box allows users to add the new tasks with a date, and also a category and 

priority. Old tasks can be easily edited by selecting the pencil icon or removed by selecting the 

red X, and other features including filtering the tasks. 

 

[3] A list of family files (Trees) with the highlighted tree that has been selected, and [4] the Web 

Dashboard, which lists available databases. Some databases may require login as shown in the 

upper right of this section. We’ll discuss this last feature at the April class. 

 

[5] A nice feature called TreeSync™ is available only through Ancestry.com. This feature 

allows users to make changes on your family tree in FTM 2014 and synchronize with the same 

public or private tree on Ancestry.com, provided you uploaded your family tree to the 

Ancestry.com website. It also works in reverse so any update you made in your family tree on 

Ancestry.com will update the family tree in your FTM 2014 software. Even smartphones can do 

this feature with the latest Ancestry app for smartphones. 

 

Adding People to Your Tree 

 

A new family pedigree screen appears under the People tab in Figure 3 as shown below. There 

are two tabs: (Family) Tree and Person. Most of your time will spent in the family tab as you 

add more family names to your tree. 

 

There are four main sections in this screen: [1] Individual Index on the left, [2] Pedigree view 

in the center, [3] Family Group view at the bottom, and [4] the editing panel on the right for the 

highlighted individual. The panels can be moved out of sight to allow more room for the center 

panel by selecting the one inch dotted lines normally in the center of each panel. 

  

[1] In the left Index panel below, users can select each individual quickly by using the scroll bar 

or enter the individual’s name in the Find search box feature. Another option is to sort by given 

names, or by birth, marriage, or death dates. A filter option at the bottom allows users to filter 

individuals in this panel such as females, ancestors, descendants, exclude single individuals or 

their families, or even filter by vital facts, or other facts. 



February 2015 Handout 
 

5 
 

 
Figure 3. Family View Screen 

 

[2] The pedigree tree above shows a list of relatives that can be moved to the left to see the 

descendants or to the right to see the ancestors by selecting the left or right arrows at either end 

of the tree chart. Users can select any name to see a pop-up chart of the vital stats of that ancestor 

and also notice their [3] Family Group view below where the children are listed. 

 

[4] In the editing panel on the right, users enter more detailed information or modify the vital 

stats in the blank spaces of the highlighted individual. Users can Customize the panel with your 

choices of facts that you want displayed inside the panel. A new options box appears with many 

optional facts to be displayed. 

 

[5] At the top right in Figure 3, users can Add new relatives such as parents, spouses, children, 

or even unrelated persons, Delete the indicated ancestor in the screen if necessary, but be careful 

doing this step. It will ask you to confirm this action as a safety step. You can also Print 

different charts, family group sheets, genealogy reports, photo albums, and a relationship chart. 

And users can Share the family tree information, although not recommended due to privacy 

issues, with Ancestry.com, convert to different formats including PDF and email the different 

charts to a relative, and export the same information to a CD or as a file to email to a relative. 

 

Adding multiple spouses to any ancestor is easy by selecting the [6] Spouse icon. A new text box 

appears, then select the gender and OK, then add the spouse info in the editing panel on the right 

1 

2 

3 

4 

5 

6 

7 

8 



February 2015 Handout 
 

6 
 

side. Users can select which spouse is preferred on the screen by selecting the Spouse icon 

button, providing two or more spouses are listed, then select the preferred individual, then check 

the Preferred Spouse box. 

 

[3] Deleting children is easy by right clicking on the child’s name and select Delete child, but be 

careful as it deletes this person entirely form the family file. If you meant to detach this child 

from either parent, then select the Person menu item at the top, then select Attach/ Detach 

Child. Add or detach child from either parent with the pop-up menu item. 

 

[7] Sorting children by birth order is easy by selecting the rotate icon to the right of the marriage 

information. In Figure 3, Users can also [8] Bookmark certain individuals that are often used in 

your family tree. Once bookmarked, they will easily be available in the same index window for 

easy access. The [8] History button allows users to view the most recent individuals you have 

edited. 

 

Tip: There are four panels on the People display. Some genealogists asked if they can make this 

version similar to an older version for simplicity sake. The outside panels can be minimized, thus 

only the center panel is shown. You can move the panels back to normal as needed. 
 

Adding Ancestor Facts 

 

Select the name or blank button in the Pedigree chart to add new names. Add the primary facts 

in the [4] editing panel. Dates can be entered in any format, but will be displayed, ie, 12 Feb 

1933, only in a certain format that you specified in Options in the Tools menu. 
 

Tip: Use backslashes on long surnames, otherwise FTM will only recognize the last word of the 

surname. Example: \Van Der Voort\ or \de la Vega\ as used by many Europeans. 
 

Tip: Enter city or town or township, county or parish, state and country for locations in the U.S. 

ranging from smallest to largest location in any field. For foreign locations, enter city or town, 

parish or district, province, and country. Some locations can be abbreviated, ie, CO for Colorado. 

 

Scroll down to the preferred one and highlight it, then select the OK button. For certain facts like 

Social Security number, enter [2] new fact in the upper center panel. You can add a source 

citation for this fact in the [4] Source panel by selecting the New button and completing the 

required information. A new text box appears, thus allowing users to complete the source 

citation.  

For custom Facts, either select the New button in the Add Facts text box, then add the custom 

Fact. If users have similar facts for similar events, you can change the priority of those facts by 

selecting Preferred using the Options button in the editing panel. 
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[5] Changing relationships is easy by selecting the Relationships button in the upper right side 

of this panel. In the [3] editing panel on the right side, select the pull down menu and select the 

desired relationship. 

Note: Special situations arise when adopting children anywhere, having foster or step children, 

children born out of wedlock, or becoming a guardian. FTM covers most of these situations 

using the Relationship button with the pull down category menu in the right panel of each 

individual. Users can assign the best relationship category for the child or parent as needed. 

 

 
Figure 4. Person View Screen 

 The FTM companion guide makes reference to this situation in Chapter four on entering family 

information. If the child isn’t adopted, then it’s difficult to trace and locate the actual parents. 

Sometimes, the real parents don’t want to be discovered, thus the records are sealed in court.  

However, as children become adults, there is a yearning to find the real parents, thus the real 

challenge begins. There are usually birth records for most everybody in the United States after 

the 1930s and sometimes, lots of additional research is required. 

[6] Users can use the Notes panel for adding biographies for the ancestor, research notes, 

legends, etc. Users can add about 200 printed note pages per ancestor. A memory gauge in the 

upper right side of this panel lets users know how much space has been used. Users also have 

two separate note pads available: Personal notes for biographies and Research notes for just 

research. You can mark either notes as Private by selecting the lock icon. 
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Tips: The Copy and Paste functions work in notes if importing information from another 

external document. If you need to expand any of the panels, simply collapse the other panels. 

Users have the ability to change the font size by moving the variable scale at the far right and 

color, use bold, italicize, or underline features with symbols in the notes text including a custom 

spell checker. 

[7] Adding Media is easy by either linking to an existing picture in your computer or making a 

copy, which takes more family file memory. I’ll discuss working with pictures and the Media 

workspace at our May class. [8] Tasks can be added using the Tasks tab similar as done in 

Figure 2 on page 3. 

The [8] Tasks are similar to a tracking journal that genealogists used in the past. Users can select 

New on the Tasks menu bar to add new tasks for follow-up later as shown below in Figure 5. 

Tasks can be checked off after completion for better organization as shown below. Users can add 

the detailed task, location, and a due date for easy follow-up. 

 
Figure 5. Tasks Box 

Tip: [2] Did you know two or three of the panels are collapsible, so the center panel is only 

visible by moving or selecting the one inch dotted lines (shown below) on the edge of each side 

or lower panel and left click and drag with your mouse. 

Creating Smart Stories™ 

Smart Stories™ is a nice feature of FTM software. This is a great narrative tool that helps you 

write family stories by selecting facts, sources, and notes that users have already entered for each 

ancestor as shown below in Figure 6. If you’re not a great writer, users can use this handy feature 

to create your own family history story on any ancestor. Users have the option of sharing it on 

the Ancestry.com website.  

They make new improvements each year with Smart Stories on adding family members for each 

ancestor. What’s nice about this feature is it automatically creates an informative family history 
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of your ancestor. The more facts added for each ancestor gives a more detailed family history. 

Try it if you’ve never written your family history. Eventually, you can combine all the Smart 

Stories™ for each ancestor into a book or larger report. 

 

Figure 6. Creating Smart Stories 

 [1] Users have two options on where to create a Smart Story™ either as a media item for any 

specific ancestor or as a publication with one or many ancestors. You have the option to share 

your family stories on Ancestry.com, but beware everyone will see them. 

I’m a big fan of family stories, so start collecting the facts and any interesting or entertaining 

family stories of your ancestors. For now, [2] just add as many new facts and biographical notes 

for any ancestor. At our September and October meetings, we’ll start creating a family history 

report or family history book on any ancestor using your family story. A Create Smart Story 

textbox will appear which users can create their family history story automatically as shown 

below in Figure 7. 

You can modify or add more information to the Smart Stories™ for each ancestor during the 

editing process. Don’t include info on relatives who are still living without their permission as 

hurt feelings on revealing facts can cause problems later. 

Tip: Add more facts under each ancestor to expand your family history story. The more facts 

provide a more interesting and appealing family history story of your ancestor.  
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Figure 7. Create Smart Story Textbox 

 

Users may want to try it soon if you don’t want to wait until our Fall classes. An example of a 

Smart Story is shown below in Figure 8. 

 

Figure 8. An Ancestor’s Smart Story 

Smart Stories  is a versatile word processor that provides many additional functions such as 

changing font styles and sizes, bolding, italicizing, underlining characters besides having an 

internal spell checker. 

As you notice, the above figure 8 shows the ancestor photo in the center. Users can change the 

photo to left alignment and then wrap the text around the photo if desired. Right click your 

mouse cursor on the photo in figure 8, then select ‘Text Wrap,’ then select ‘Square’ as shown 

below in figure 9.  Move the photo by left clicking and holding the mouse left button and 
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dragging the photo to the left margin as shown and you’re done. The text moves automatically to 

the right of the photo. 

 

Figure 9. Using Text Wrapping Feature 

Adding Photos, Documents, and Notes 

Users can add photos, scan or download document images from Internet databases, or copy and 

paste Notes into the Smart Stories  family history of each ancestor. There are two methods of 

adding photos to your Smart story. Place your mouse cursor where you want the photo to appear 

in your Smart Story. 

[1] The first method uses the word processor top menu as shown in figure 10 below. Select 

‘Insert’ from the word processor menu and select ‘Add image from Media Collection’ to insert 

any photo that you have added to the Media section. If you don’t have any photos of your 

ancestor, you will need to add photos either into your computer, then into your media collection. 

Another option is to add photos to your computer, then select ‘Add From File’ from your 

computer photo files into your Smart Story. 

[2] The second method uses the right panel options on adding any media, notes, sources, or facts 

to your Smart Story as shown below in figure 10. Select the ‘Media’ icon, which all the ancestor 

media photos and other media types will appear (provided you have added these items to your 

media library for each ancestor). [3] Then scroll down the media items and select which photo 

you prefer to add into your Smart Story and select the ‘Insert’ button in the top right panel. Or 

you can simply drag and drop the preferred photo to the appropriate section in our Smart Story. 
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Figure 10. Adding Photos or Other Media to Smart Stories 

Saving and Sending Your Smart Story to Relatives 

FTM allows you to save your Smart Story for each ancestor and sending it as an attachment in an 

email to your relatives and friends. This is a nice feature to share your ancestor stories with your 

relatives, especially your children and grandchildren. 

Select File>Save As from the word processor menu at the top. A new text box appears which you 

type in your ancestor’s name and select the ‘Save as Type’ with a pull down menu as a Adobe 

PDF file format as shown in figure 11 below. Adobe PDF is the international standard for saving 

and sending these type of files in an email attachment. 

First, select where you want to save your Smart Story into which folder on your computer as 

noted below. I created a new folder called [1] Biographies inside the main Family Tree Maker 

folder inside Documents or My Library Documents depending on which version of Windows 

(xp, Vista 7, or 8) you use. [2] Type in your ‘File Name’ for your ancestor Smart Story as noted 

below. [3] Select the PDF file format and [4] select the ‘Save’ button. 

You can always return to any ancestor story for later editing or adding more photos or other 

images as needed. You will need to return to the People Workspace, Person tab for the selected 

ancestor, Media tab at the bottom panel and select their Smart Story in the media items for 

editing. Simply double click on the Smart Story to open the existing ancestor story for editing. 
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Figure 11. Saving Your Smart Story 

Users can also select the blank Smart Story method selecting the Publish Workspace button, then 

select ‘Other’ option in the left panel and select the bland ‘Smart Story.’ Then copy and paste 

your biographical sketch of any ancestor using the Notes section under the Person tab for any 

ancestor. 

To send an email attachment, open your email program and create a new email. Select the attach 

feature and select the preferred ancestor story from your FTM Biography folder and attach it to 

the email and send to your relatives and friends.  

Tip: See Gwen and Boyd Johnson’s 2010 how to book, Write Now! Tell Your Family Story for 

information on where to gather all these facts and family stories. We’ll use their book in the 

advanced class on writing and publishing your family history in our November class. We offer 

them on our website for $20 each. 

Homework Assignment 

 

During your research, start looking into each ancestor to see if they may have some interesting 

facts about them to create a nice family history. If you start now, you’ll be surprised how easy it 

is to create a family history on each ancestor using the Smart Story™ concept. Each family 

history story doesn’t have to be more than one to three pages including photos. Make this a 

priority for your last two generations. Before you know it, you’ll have enough stories to create a 

family history book after three to five years of researching your ancestors. 

Please use the Help menu or the FTM manual included with your FTM software DVD or watch 

online on the Family Tree Maker website, if you have problems. If you still have any problems, 

please email me at FTM@lcgsco.org. 
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